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The N1911A/12A P-Series power meter makes WilMAX burst signal
measurement simpler with its one-button preset

Introduction

This demo guide is designed to help engineers make effective power-time
measurements with the P-Series power meters.

Included in this guide are an overview of the WiMAX technology and a step-
by-step demonstration of Mobile WiMAX™ (OFDMA) waveform measurements
in TDD mode. Power-time and CCDF measurements are covered in various
subframes: DL, UL, both DL and UL subframes.

Use the N1911A/12A for Effective WiMAX Burst Signal
Measurement

* Power Versus Time (PvT)
+ Power Statistical CCDF

The N1911A/12A P-Series power meters and N1921A/22A wideband power
sensors combination can perform fast and accurate measurements of peak/
average/peak-to-average ratio power, rise/fall time, maximum/minimum power
and CCDF statistical data for wideband signals.

With the P-Series power meters’ 30 MHz wide video bandwidth and 100 MSa/s
continuous sampling rate, capturing high-burst WiMAX signals is a breeze, even
with the signals’ fast power transitions.

The P-Series power sensors provide high dynamic range for better sensitivity,
enabling reliable measurement of peak and average power. These diode sensors
also come with wide frequency ranges up to 40 GHz to easily capture high-
frequency WiMAX signals.

Further simplifying measurement set up, the P-Series power meters provide a
one-hutton preset for WiMAX signals so you can effectively capture your desired
signal burst faster. With easy steps in this demo guide for PvT and statistical
CCDF measurements, you can also evaluate your WiMAX application designs
sooner.



WiMAX Overview

Worldwide Interoperability for
Microwave Access (WiMAX) is based
on wireless transmission methods
defined by the IEEE 802.16 standard
that offers high-speed data access

to large geographical areas, covering
a distance up to 20 miles. WiMAX
was developed to replace broadband
cable networks and to enable mobile
broadband wireless access.

The orignal IEEE 802.16 standard
offers a 10 GHz — 66 GHz point-to-point
system using traditional single carrier
modulation with QAM. However, it has
little industry adoption.

The IEEE 802.16-2004 [1] standard,
defines the Physical layer (PHY),

and Medium Access Control (MAC)
protocol for products that extend
Broadband Wireless Access (BWA)
from the Local Area Network (LAN).
The standard contains specifications
for licensed and unlicensed BWA
operations between 2 GHz and 11 GHz.

The IEEE 802.16-2004 standard
specifies Orthogonal Frequency
Division Multiplexing (OFDM) as the
transmission method for Non-Line-
0f-Sight (NLOS) connections to attain
a high data rate. OFDM modulation
uses up to 256 subcarriers with
bandwidths of 1.25 MHz to 28 MHz.
Subcarriers are spaced such that
they are orthogonal to each other,
thus reducing signal interference.
The signal bandwidth in the Base
Station (BS) can be changed based
on transmission distance and signal
environment. The network provider
may also determine the bandwidths
available for users based on various
pricing plans. Signal condition and
bandwidth requirements determine
which modulation will be selected for
the individual data burst.
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Figure 1. OFDM (fixed) and OFDMA (mobile) frame structures

Table 1. OFDM and OFDMA standards

Fixed WiMAX Mobile WiMAX
(OFDM) (OFDMA)
Standard 802.16 802.16/802.16- | 802.16e/802.16-2005
2004
Multiple access FDD, TDD FDD, TDD FDD, TDD, OFDMA
Modulation single carrier | OFDM with BPSK, | OFDMA with BPSK,
with QAM QPSK, 16QAM, QPSK, 16QAM,
640AM 640AM

Channel spacing 1.25 MHz to 28 MHz

FFT size 256 2048 1024, 512, 128
User carriers 200 various
Pilot carriers 8 various
Frequency range 0 to 66 GHz 2to 11 GHz < 6 GHz Licensed
Licensed Licensed and
Unlicensed
Application NLOS LOS

Figure 1 shows the OFDM and Orthogonal Frequency Division Multiple Access
(OFDMA) frame concepts. In OFDM, the downlink consists of the Preamble (P)
followed by a Frame Control Header (FCH) and the subsequent bursts for the
respecitve different subscribers. In OFDMA, the bursts are allocated according to
a downlink map. The data bursts that overlap the same specifications maximise
the data flow in a complex enviroment.

Table 1 is the summary of OFDM and OFDMA standards. The 802.16-2005
standard focuses on the OFDMA layer. OFDMA allows 128, 512, 1024 or 2048
subcarriers in 1.25, 5, 10, 20 or 28 MHz bandwidths respectively.



OFDM/OFDMA Subcarriers

The WiMAX specifications for the 256-
carrier OFDM PHY define three types
of subcarriers: data, pilot, and null.
WIMAX standard specifications for the
200 carriers are used for data and pilot
subcarriers. Eight pilot subcarriers

are permanently spaced throughout
the OFDM spectrum. Therefore, the
data subcarriers take up the other

192 active carriers. The remaining 56
potential carriers are nulled and set
aside for guard bands and removal of
the center frequency subcarriers [2].

Figure 2 shows the comparison
standards between Wireless LAN
(based on 802.11) and WiMAX (based
on 802.16). In WLAN signals, 52
carriers are used, where 48 carriers
provide data and four carriers provide
pilots. In WiMAX signals, only 200

of the possible 256 carriers are used.
These are numbered between —100
to +100. The center frequency carrier
(#0) will not be used.

Out of the 200 carriers, 192 of the
carriers are used for data, and eight
carriers are used for pilots. WiMAX
signals can be configured with the
bandwidths ranging between 1.25
MHz to 28 MHz. Figure 2 shows an
example of a 1.5 MHz-bandwidth
signal, where its carriers are spaced
at only 6.7 kHz from each other. In
WLAN signals, however, the individual
subcarriers are spaced at over 300 kHz
from each other.

While WiMAX signals have
significantly more subcarriers and
data in each symbol, they do not

have a significantly higher data

rate than WLAN signals. That's
because in OFDM, when the carriers
become more closely spaced, the
symbol period must be increased
proportionately to maintain the
orthogonality of the individual carriers.

A longer symbol period means a
higher resistance towards channel
impairment such as multipath fading,
thus, it is more advantageous to use
more closely spaced carriers with the
proportionately longer symbol period.
This advantage allows WiMAX signals
to transmit data more effectively over
long distances and in NLOS, compared
to WLAN signal.

In OFDMA mode, various subscribers
can be served simultaneously by
assigning each subscriber a specific
carrier group (subchannelization)
that carries the data intended for that
subscriber (see Figure 3).
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Figure 2. 802.11a WLAN versus 802.16 WiMAX standards
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802.16 Concept: Subchannelization

Subchannelization is an optional
capability that can be supported by
subscriber and Base Stations (BS).
Figure 4 shows the Uplink
subchannelization. One subchannel
contains 12 carriers. The OFDM
WiMAX has 192 active data carriers,
so there are 16 subchannels in
total. They are allocated in various
combinations for the creation of

31 different configurations to be
assigned to a user. (Details on

subchannelization can be found in [1],

Table 213 for OFDM.)

In the most basic operation, all 16
subchannels (all 192 carriers) are
assigned to a single user. In the most
complex configuration, 16 users are
assigned to one subchannel. The
downlink symbol would still contain
all 192 carriers, but each individual
user’s data would only have 12
carriers. For uplink, all 16 users would
transmit signals simultaneously, so
their signals will arrive at the BS at
the same time and with approximately
the same power.

It is important to align the subscriber’s
station time, frequency, and

amplitude so that the BS can receive,
demodulate and decode informations
from 16 different transmitters
simultaneously.
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Figure 4. Uplink Subchannelization

Modulation Type

The IEEE 802.16-2004 standard
defines a set of adaptive modulation
and coding (AMC) rate configuration
that can be used to trade-off data
rates for system robustness under
various wireless propagation and
interference conditions. When the
radio link quality is good, the WiMAX
system can use higher-order
modulation schemes (more bits or
symbol) that will result in more
system capacity.

When link conditions are poor due

to problems such as signal fading or
interference, the WiMAX system can
change to lower modulation schemes
to maintain an acceptable radio link
margin. The allowed modulation types
are Binary Phase Shift Keying (BPSK),
Quadrature Phase Shift Keying (QPSK),
16 Quadrature Amplitude Modulation
(16QAM) and 640AM [2].




Duplexing Techniques

WIMAX systems can be deployed

as Time Division Duplexing (TDD),
Frequency Division Duplexing (FDD), or
Half-Duplex FDD (see Figure 5).

In the TDD configuration, the BS and
subscriber equipment transmit on the
same RF frequency, but at a different
time. The Downlink (DL) subframe is
transmitted by the BS, followed by a
short gap called Transmit/Receive
Transition Gap (TTG), whereas the
Uplink (UL) subframe is transmitted
by the individual subscriber.

The subscribers are accurately
synchronized so that their
transmissions do not overlap each
other as they arrive at the BS. There is
another short gap called

the Receive/Transmit Transition Gap
(RTG) after the Uplink subframe is
allocated before the BS can start
transmitting again.

A Downlink subframe always begins
with a Preamble (P), followed by a
Header (H), and one or more downlink
bursts of data. The downlink bursts
are generally made up of multiple
symbols within the burst. Within

each burst, the modulation type is
constant, but the modulation type can
change from burst to burst. “Robust”
bursts such as BPSK and QPSK must
be transmitted first, followed by less
robust modulation types (QAM). The
order of the robust burst, from most
to less robust is BPSK, QPSK, 16QAM,
followed by 64QAM. Each UL
subframe is preceded by a Preamble,
called a “short Preamble”, which
allows the BS to synchronize with
each subscriber on its own.

In the FDD configuration, the downlink
and uplink frames are identical to

the TDD, but they are transmitted on
separate RF frequencies and overlap
each other at a specific time. No TTG
or RTG gaps are required in this FDD
mode.

The Half-Duplex FDD configuration
combines the characteristics of

FDD and TDD. However, the BS and
subscriber equipment transmit on
different frequencies like FDD, and at
different times like TDD.
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Figure 5. Various duplexing techniques (TDD, FDD and H-FDD)




Output Power

Power level transmission is an
important [EEE 802.16 conformance
specification. It is defined as the
time-averaged power over the useful
period of a UL or DL subframe burst.
Peak-to-average power can also be
obtained during this period. To make
accurate and stable measurements,
it is important to be able to capture
the desired complete subframe
consistently within the fixed
timeframe. This can be achieved

by applying proper time-triggering
mechanisms such as trigger level,
holdoff and delay that are available in
the P-Series power meters.

The P-Series power meters’ trigger
level is typically set at auto-level.
Trigger holdoff ensures that the
acquisition will not occur until the
holdoff time has passed and a valid
trigger is found. This is very useful
for burst signals that have amplitude
variations because these variations
can cause false triggering.
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Figure 7. CCDF plot: Y axis represents the percentage of time the
signal power is at or exceeds the power specified by the

X axis

Trigger delay allows measurements of
different signals. By just changing the
delay setting of the power meter, you

can make power measurements of the

next subframe.
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Figure 6. WiMAX burst power profile (without constant duty cycle)
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CCDF

The Complementary Cumulative
Distribution Function (CCDF) is a plot
of probability versus Peak-to-Average
Ratio (PAR), which characterizes the
power statistics of a signal. CCDF is
one of the important measurements
in designing WiMAX power amplifiers
that must be capable of handling high
PAR signal exhibits while constantly
maintaining good adjacent channel
leakage performance.

The CCDF plot is primarily used in the
wireless communications market for
evaluating multicarrier power amplifier
performance. It provides a measure-
ment of the percentage of time where
the PAR is at or exceeds a specific
power level.




Demonstration Preparation

This demonstration focuses on
Mobile WiMAX (OFDMA) signal
measurements over LAN.

The following instruments and

software are used in this demo guide:

+ E4438C ESG vector signal generator’

* NT1911A/N1912A P-Series power
meters

* N1921A/N1922A P-Series wideband
power sensors

+ N7615A/B Signal Studio software?

The Signal Studio is a Windows®-
based utility that simplifies the
creation of standard or customized
WiMAX waveforms. With the Signal
Studio software, the desired Mobile
WiMAX waveform can be configured.
Waveform parameters are then input
to the ESG.

To update instrument firmware and

software, visit:

* www.agilent.com/find/esg

* www.agilent.com/find/mxg

* www.agilent.com/find/wideband_
powermeters

+ www.agilent.com/find/signalstudio

1 Alternatively, you can use the N5182A MXG vector signal generator, firmware revision 1.10 or later, frequency range option: 503 or 506, and baseband

generator option: 651 or 652.

Product type Description
ESG Vector Signal + E4438C firmware revision C.04.60 or later
Generator * Frequency range option: 503 or 506

» Baseband generator option: 601 or 602

P-Series Power Meters

N1911A or N1912A firmware revision A.03.01 or
later

P-Series Wideband
Power Sensors

N1921A or N1922A

Signal Studio software

N7615B Version 1.8.2.0 or later

Controller PC

Installed with the N7615B Signal Studio software
(to generate and input the WiMAX signal into the
ESG)

Refer to online documentation for installation and setup.

2 The N7615A/B is for Mobile WiMAX signal measurements. For Fixed WiMAX signal measurements, the N7613A/B can be use.



Demonstration Preparation (continued)

Connecting the PC, ESG and P-Series
Instructions

1. Connect the PC to the E4438C ESG
via a LAN cable.

2. Launch the Agilent Connection
Expert application (Agilent |0
Libraries Suite) and verify
successful connection of the ESG.

3. Connect the P-Series power meter
and sensors as shown in Figure 8.

Establishing a communication link to
the ESG

Keystrokes surrounded by [ ] represent
front panel keys of the instruments,
while keystrokes surrounded by { }
represent softkeys.

-

LAN on ESG
back panel

N1912A
Channel A

P Lot n

N1921A

Figure 8 P-Series and ESG setup diagram

Instructions Keystrokes

On the ESG:

1. Set the instrument to its default Press [Preset]
settings.

2. Check the IP address.

Press [Utility] {GPIB/RS-232/LAN}

{LAN Setup}

« if connecting to a network, press
{LAN Config} {DHCP}

« if direct-connecting from PC to ESG,
press {LAN Config } {Manual},
e.g. {IP address 192.168.100.1}

3. Run the Signal Studio for
802.16 WiMAX.

Double-click on the 802.16 WiMAX
shortcut on the desktop or access the
program via Windows start menu.

4. Verify that the software is
communicating with the
instrument via LAN TCP/IP
link.

From the {System} pull-down menu at
the top of the Signal Studio program
window, select {Change Hardware
Connections} {Next}, select [LAN] and
enter the host name or IP

address of the ESG in the address
area. Finally, click {Test 1/0
Connection} {Next}.

5. The software should return a
“success” connection status.

« If connection is successful, click
{Finish}.

* If connection is not successful,
verify the instrument connection
and the IP address or TCP/IP link
again.




DL Profile in TDD Mode

Profile setting

Most parameters are in their default
settings when Signal Studio is
launched. Values in bold indicate
modified parameters.

Instructions

Software operations

On the Signal Studio software:

1. Set the basic parameters of
the signal at center frequency
3.5 GHz, amplitude at 0 dBm.
Turn RF output and ALC ON.

Click Signal Generator on the left of the
Explorer menu.

* Instrument model number = E4438C
Select [Preset] at the top of the selection
menu.

* Frequency = 3.5 GHz

* Amplitude = 0 dBm

* RF Output = On

+«ALC=0n

2. Configure waveform setup.

Click Waveform Setup. Under Waveform
Properties, set the parameters as follows:
* Built frames = 1

* Frame duration =5 ms

* Output mode = Downlink only (TDD)

* Downlink Ratio (%) = 50.0000

* Downlink duration (ms) = 5.0000

* Uplink duration (ms) = 0.0000

* Guard period =1/8

* Symbol rolloff = 5.0 %

3. Configure test signal.

Click Carrier 1. Under Waveform

Setup on the left of the Explorer menu.
Carrier 1:

« State = On

* Radio format = advanced 802.16 OFDMA
*BW =10 MHz

* FFT size = 1024

* Frequency offset = 0 Hz

* Power = 0.00 dB

Reference specifications: 802.16e-2005
with PRBS Method Cor1/D3. Single-carri-
er with 10 MHz bandwidth, 1024 FFT size
and 28/25 n.

4. Create a single-carrier signal
that includes downlink only.

Click Downlink and set the following

parameters:

* Preamble index = 0

* Group bitmax = 111111 [Binary],
3F [Hex]

* Number of symbols = 20

» Symbol offset = 1

* Max number of subch = 30

5. Configure Zone No. 1, PUSC.

Select Zone No. 1 PUSC MAC messaging
and set the following parameters:

* Zone boost = Off

* Number of symbols = 20

* Auto allocation = On

+ Auto FCH = 0On

* Auto DL-MAP = Off

* Auto UL-MAP = Off

10



DL Profile in TDD Mode (cont.)

Profile setting (cont.)

Instructions

Software operations

6. Configure MAC messaging.

+ Auto DL-MAP = Off
* Modulation and coding = QPSK (CC) 1/2
* Repetition coding = None

7. Configure Burst No. 1.

Select Burst No. 1 and set the following
parameters:

+ Modulation and coding = QPSK (CC) 1/2
* Repetition coding = None

* Power boost = 0 dB

* Data Length (Bytes) = 1000

8. Download signal to ESG.

On the menu bar, go to

Control > Generate and Download.
If you encounter any errors, refer to
Signal Studio’s online help.

9. Save file setting for future
use.

File > Save As... > OFDMA_Demo.scp
(Insert the file name of your choice)

10. Export waveform file for
future use.

File > Export Waveform Data > OFDMA_
Demo.wfm (Insert the file name of your
choice)

1"



DL Profile in TDD Mode (cont.)

PvT Measurement Measuring DL PvT
Power versus time (PvT) measurement

. . . Instructions Keystrokes

examines the time domain burst -
structure over certain subframes. On the P-Series power meter:

1. Select WiMAX preset O v
The P-Series power meters’ real-time [Preset], Press [ &2 or ] key to
markers allow users to move the choose {WiMAX}. [Select], {Confirm}.
markers manually to measure the 2. Set trace display. [Disp], {Disp Type}, {Trace}.
desired subrame burst 3. Set trigger holdoff at 4 ms, [Trig/Acq], {Settings}, {1 of 2}, {Hold-
In IEEE 802.16, there is no specific off 4 ms}.
definition for power. Thus, users are 4. Expand the window. Change the J_aaj
required to specify the design of the scale. Move the marker to [ 1. {Trace Control}, {X Start
frame based on their measurements. measure frame duration -400 ps, X Scale 600 ps and Y Scale

(see Figure 9). 10 dB} {Gate Control}, press

Figure 9 shows the PvT graph for an [ 2] to allocate marker 2 and [@]
entire WiMAX burst signal within
a frame duration of 5 ms (refer to to allocate marker 1.

waveform setup on Page 10).

The Signal Studio under Downlink Gate Ctrl

step shows a frame duration of 5 ms Al A,

(see Figure 10). Moving the cursor Gat

around the frame zone reveals the II'Il‘i! '1K|| i, "|I"" ©
i h”q hdz34

time duration and power level of the
Preamble, DL, TTG, UL and RTG as
seen below:

* Preamble =0.104 ms / 1 sym

”u' W i ’l”' q ”‘

—_——

» DL =2.06 ms / 20 sym(s) Marker |

* 176G =0.34 ms JCStart400us_600us /Div ¥ :Top 20 004Bm10 0E D !

UL =1.85 ms / 18 sym(s) 4 Time: -8.70us | AT 5.01ms \

* RTG =0.648 ms Pow: -69.15dBm | Aug: _8.54dBm Trace'
Control

) ) HTime: 5.00ms Peak: 7.00dBm
The Preamble region (Figure 10) Pow: -046dBm | PK-Avg: 15.53dB
shows 0 dB. In DL zone, there are ‘ 10f2 )

three different power levels: ] ] ] ‘ ]
i) —3.98 dB when the FCH and Burst 1 Figure 9. WiMAX waveform duration at 5 ms for DL in TDD
. - mode. In the P-Series power meters, green lines
i '34(1': (ggghthafter treBPreiTplez)N (Gatel1 and Gate2) are used to highlight the burst
I —4. whnen only burst 1 1s structure of the WiMAX profile.
ii) —10.27 dB from the end of Burst 1 to
the end of the DL zone.

Frame ]

UL ZoneH1 GaplRTG)

EPUSC UL Zone#1

| Type: PUSC Gap(RTG)
Length: 18 sym(s) Length: 648.57 us
Max# of Subch:35 ch(s) Amplitude: --- dB
Amplitude: --- dB

Amplitude: -10.27 dB

Gap(TTG)
Length: 340,00 us

Seament Index: 0 L !
Amplitude: 0,00 d& Amplitude: -3.98 dB Arnnlude. --- db

5000 s

Figure 10. Frame duration (5 ms) of DL waveform captured with Signal Studio
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Measuring Preamble and DL PvT
Instructions

Keystrokes

On the P-Series power meter:

1. Measure Preamble at 104 pus
duration (see Figure 11).

{Trace Control}, {X Start —200 ps and
X Scale 300 ps}. {Gate Control}. Press

[ [ *] to allocate marker 2 and [ 1.]

to allocate marker 1.

2. Measure DL with only Burst 1
ON (see Figure 12).

Press [ [ *] to allocate marker 2 and

[ x'] to allocate marker 1.

Al
3 -1;| n .1'| ) \'l.”l I‘-\ f"|1| i Mﬂ

|

Wy ww

1 Time: -4.35us AT:
Pow: -63.15dBm | pug:

A Time: 100us | Peak:

__Pow: -1.71dBm__| Pk-Avg:

i ||)| \

X:Stant-200us 300us /Div Y Top 20 004Bm 10 004 E'Diw

104us
0.04dBrn
410dBrm
4.06dB

_ Gate Ctrl

[ a S
Gate

234

=S
Select

[ TaDel

—_—

LW
Marker
1

i ——
LY
Trace
Comntrol
—

10f2 b

Figure 11. Preamble duration at 104 us and average power
is measured at 0.04 dBm, which is close to 0 dBm
of input power (see ESG setup on Page 10)

Gate Ctrl
A J j B
kot
[I g Hllf' U"llﬂ'.ull ﬂwﬂﬂl ‘-.ﬁ.ﬂ.,w"r.n I". lL n # "~ Il}j ga;:
e
Select
w’ (I TgDel
| ’ Marker
H:Start-200us  300us fDiv Y:Tupi'[! 00d Brn 1000 Ef Dlivwt ﬂ 2
i Time: 37dus | AT: 1.25ms
Pow: -12.56dBm || pug: -4.52dBm CJI::’:;
2 Time: 1.63ms Peak: 6.44dBm
Pow: -18.76dBm | PK-Avg: 10.95dB
10f2 b

Figure 12. DL average power measures —4.52 dBm at 1.25 ms
where only Burst 1 is ON. Referring to Figure 11,
the Preamble (P) has a 3 dB boost above the DL or
nominal level of the rest of the signals. At times,
bursts can be boosted above 0 dB as well.
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Measuring TTG, UL and RTG PvT
Instructions Keystrokes

On the P-Series power meter:

Measure the TTG, UL and RTG at 2.84

i
ms duration (see Figure 13). Pr’e_:s [[""‘ I to allocate marker 2 and
[C“-_-I] to allocate marker 1.

RMT
Gate Ctrl
Al A
' |
H\hl‘qﬁrﬁlﬂhll |H"i\f||hh“t.l' M['|H| } \,I.W'Iﬁ i] ga;:
U e
e it =
| LT —
. L’ . a2
H:Start-400us G00us SDiv Y :Top20.00d Brml 000 Bf D
i Time: 2.16ms AT: 2.84me
_ Pow: -6.36dBm | Aug:  -14.07dBm C:;::;r
2 Time: 5.00ms Peak: 0.59dBm
Pow: -0.16dBm Pk-Avqg: 14.66dB
10f2 b

Figure 13. TTG, UL and RTG at 2.84 ms duration
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DL Profile in TDD Mode (cont.)

Power Statistics CCDF Measurement
Prior to measurement, a reference
trace is set and compared with the
Gaussian noise trace.

CCDF is generally measured with
data that is as random as possible to
match the Gaussian Curve. The CCDF
waveform provides statistics of the
input signal, analyzed over

1 s asynchronously to any features
of the signal. 100 MHz samples are
histogrammed in real time so we can
have the statistics on 100 million
samples.

The P-Series power meters provide
waveform CCDF measurements in
graphical and table formats (see
Figures 14 and 15). The Preamble and
Header portion of the waveform are

fixed data, thus causing the yellow line

curve on the CCDF plot to extend past
the Gaussian Curve and therefore,
displaying a very high PAR (see Figure
14).

Referring to Figures 16 and 17, the
Signal Studio under Waveform Setup
shows that the CCDF plot and the
table to the left of the CCDF plot
display the calculated peak-to-average
values. The blue line represents the
Gaussian noise and the yellow line
represents the input signal. Click the
Waveform CCDF or Burst CCDF button
to toggle between the calculation
types.

Instructions

Keystrokes

On the P-Series power meter:

1. Set acquisition to “Free Run”

[Trig/Acq], {Acqn A}, {Free Run}.

2. Measure CCDF in trace format

[Disp], {Disp Type}, {1 of 2}, {CCDF
Trace}.

3. Set trace scale to 20 dB

{Trace Control}, {Scale/Div 2dB}.

4. Set up Gaussian noise and
expand the display (see Figure 14)

{Trace Display}, {Gaussian}, [ f) 1.

5. Set CCDF in table format and
expand the display (see Figure 15)

[Disp], {Disp Type}, {1 of 2}, {CCDF
Table}, [ ceg)

15.1?dE
10.0162%

100M

20,0048
Pk-Avg(A):
15.52dB

Avg(A)-§.47dBm
Pk(A): 7.05dBm

E1 0.28dB
1.0429%

Figure 14. CCDF graphical format. The yellow line is the

input signal. The blue reference line is the band-
limited Gaussian noise curve. Marker 1 and Marker
2 indicate 10% and 1% of time at a specified power
measurement.

CCDF
~ Table
10% | 5.20dB | £ g ustical
1% | 10.30dB | smngs'|
0.1% | 12.14dB
0.01% | 13.43dB
0.001% | 14.86dB
0.0001% | 15.44dB
o5 | 0.00000 :15.474 dB
dB | 0.0000 : 3.803 %

Sample Count : 100M
Elapsed Count : 100M
10of1

Figure 15. CCDF table format
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CCODF | ‘waveform | Power Envelope |
Bl Gaussian B8 Reference  [@Acquie Ref. B Waveform CCDF - ~

001z
0.00

0.0001%
0.00 dB

Figure 16. Waveform CCDF calculates CCDF and peak-to-average ratio using the entire waveform, including portions
where the data is at zero (no signal).

CCDF | Wavefom | Power Envelope ]
BiGaussion B8 Reference  [@)Acquire Ref B Bust CCDF

0,00 dB

Figure 17. Burst CCDF calculates the entire waveform using only the actual signal instead of the whole waveform.
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UL Profile in TDD Mode

Profile setting Instructions

Software operations

On the Signal Studio software:

1. Configure waveform setup.

Click Waveform Setup. Under Wave-
form Properties, set the parameters as
follows:

* Built frames = 1

* Frame duration =5 ms

* Qutput mode = Uplink only (TDD)

* Downlink Ratio (%) = 50.0000

* Downlink duration (ms) = 5.0000

* Uplink duration (ms) = 0.0000

* Guard period = 1/8

» Symbol rolloff =5.0 %

2. Configure Uplink Burst No. 1.

Select Burst No. 1 and set the following
parameters:

* Modulation and coding = QPSK (CC)
1/2

* Repetition coding = None

* Power boost = 0 dB

* Data Length (Bytes) = 1000

3. Download signal to ESG.

On the menu bar, go to
Control > Generate and Download.

17



UL Profile in TDD Mode (cont.)

PvT Measurement Measuring UL PvT

The Signal Studio under Uplink step Instructions Keystrokes
shows a frame duration of 5 ms (see
Figure 19). The frame duration setting

On the P-Series power meter:

: - 1. Select WIMAX preset. &
is the same as the I?L profile setup but [Preset], Press [ Q or v I key to
the Uplink region will show —0.15 dB h (WiMAX}. [Select], {Confirm}
when only UL Burst 1 is ON. choose  1o€7eCh, 110 .
2. Set trace display. [Disp]. {Disp Type}, {Trace}.
3. Set trigger holdoff 4 ms. [Trig/Acq], {Settings}, {1 of 2},

{Holdoff 4 ms}

4. Expand the window. Change the @
scale. Move the marker to [ 1. {Trace Control}, {X Start
measure 5 ms waveform duration 1.5 ms, X Scale 600 us and Y Scale
(see Figure 18). 10 dB}, {Gate Control}.

Press [ B ] to allocate marker 2 and
[G] to allocate marker 1.

" RMT |
Gate Ctrl
- n

Iﬁ Y A Gate
l ’V ] g23a
—————r
[ ” H | ” ‘ I Select
h'l_h | ’ ’ ” | | [EIT3S TaDel
)EStart 1.50m=600us /Div Y :.TopZ0 .Dﬂdﬂmm.ul.'ldEFDw 2
g Time: 1.84ms AT 5.01ms E— S
Pow: -3.26dBm Avg: -4.34dBm o »
2 Time: 6.85ms Peak: 11.60dBm )

Pow: -69.15dBm | Pk-Avg: 15.94dB
I 1o0f 2 F

Flgure 18. WiMAX waveform duration at 5 ms for UL in TDD mode

Pr DL Zone# Gap(TTG) ef Gap(RTG]

e PUSC

a

m : Gap(TTG) Gap(RTG)

bl ; Length: 340,00 us Length: 648.57 us
e : amplitude; --- dB amplitude: --- dB

UL Zone#1

Type: PUSC

Length: 18 sym(s)
Max# of Subch:35 chis)
Amplitude: -0,15 dB

5.000 ms

Figure 19. Frame duration (5 ms) of UL waveform captured with Signal Studio
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Measuring UL average power
Instructions

Keystrokes
On the P-Series power meter:
Measure UL at 1.83 ms duration b [\ i cer 2 and
(see Figure 20). ress[ =] to allocate marker 2 an

il
[ x'] to allocate marker 1.

Gate Ctrl
| A
HH H‘-« [."'1*"1"?5” Gate
i d234
—
”M ‘H m | '” Select|
’ . l EN TaDel
(It il x
L Marker
H:Start 1 ﬁﬂmsﬁﬂﬂus Dy ¥ Top20 00dBm10.00d E/Diw n 2
ﬂ Time: 5.02ms | AT: 1.83ms N
Pow: 6.05dBm | pug: _0.04dBm CT;:CBI
2 Time: 6.85ms Peak:  11.59dBm omtro
Pow: -69.15dBm | Pk-Avg: 11.863dB
10f2 )

Figure 20. UL average power measures —0.04 dBm at 1.83 ms duration

Measuring RTG, Preamble, DL and TTG PvT

Instructions Keystrokes

On the P-Series power meter:

Measure RTG, Preamble, DL [\
and TTG at 3.16 ms duration Press [ I==*"] to allocate marker 2 and

: =
(see Figure 21). [ x'] to allocate marker 1.

RMT
Gate Ctrl
I| f"l‘ ..,,p.u Gate
1 ] g23a
H IR =
\( \ (7 Tabel
| i | u Marker
X Start 1 S0ms600us /D Y TDDED L0dBm 10 .00d E'Diw 1 .
1 Time: 1.84ms AT 316ms i
Pow: -2.48dBm  Avg:  16.860Bm oo
HTime: 5.00ms Peak: 8.35dBm =
Pow: -4.03dBm__ Pk-Avg: 24.24dB
10f2 b

Figure 21. RTG, Preamble, DL and TTG at 3.16 ms duration
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DL and UL profile in TDD mode

Profile setting

Instructions

Software operations

On the Signal Studio software:

1. Configure waveform setup.

Click Waveform Setup to see the setup
of the fundamental waveform signal.
Under Waveform Properties, you can set
WiMAX common parameters as follows:
* Built frames =1

* Frame duration =5 ms

* Output mode = Both DL and UL (TDD)
* Downlink Ratio (%) = 50.0000

* Downlink duration (ms) = 5.0000

* Uplink duration (ms) = 0.0000

* Guard period = 1/8

« Symbol rolloff = 5.0 %

2. Configure the number of signals
in Uplink to make the RTG a
longer period

Click Uplink and set the following param-
eters:

* Number of symbols = 15

» Symbol offset = 0

* Max number of subchs = 35

3. Download signal to ESG.

On the menu bar, go to
Control > Generate and Download.
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DL and UL profile in TDD mode (cont.)

PvT Measurement

The Signal Studio under Downlink step
shows the frame duration of

5 ms (see Figure 23). Moving the
cursor around the frame zone shows
the time duration and power level of
the Preamble, DL, TTG, UL and RTG as
shown below:

* Preamble = 0.104 ms / 1 sym

* DL=2.06 ms / 20 sym(s)

* TTG=0.34 ms
* UL=153 ms / 15 sym(s)
* RTG =0.957 ms

Preamble region shows 0 dB. In DL

zone there are three different power

levels:

i) —3.98 dB when the FCH and Burst 1
is one (right after the Preamble)

ii) —4.46 dB when only Burst 1 is ON

ii) —10.27 dB from the end of Burst 1

to the end of the zone. (Same as DL

waveform setup)

The UL zone shows two different

power levels:

i) —4.45 dB when only Burst 1is ON

ii) —4.58 dB from the end of Burst 1 to
the end of the UL zone.

Lenagth: 20 sym(s)

Use All SC: OFf

Max# of Subch: 30 chis)
Amplitude: -3.95 dB

oL m

Measuring DL and UL PvT
Instructions

Keystrokes

On the P-Series power meter:

1. Select WiMAX preset.

[Preset], press [ O or W ] key to
choose {WiMAX}. [Select], {Confirm}.

2. Set trace display.

[Disp], {Disp Type}, {Trace}.

3. Set trigger holdoff at 4 ms.

[Trig/Acql, {Settings}, {1 of 2},
{Holdoff 4 ms}.

4. Expand the window. Change the
scale. Move the marker to
measure 5 ms waveform duration.
Once the complete waveform on
the screen is within 5 ms for
markers 1 and 2, stop the
triggering (see Figure 22).

[ J_»E) ]. {Trace Control}, {X Start
—400 ps, X Scale 600 ps and Y Scale
310 dB}, {Gate Control}.

Press [ @ ] to allocate marker 2 and

[Q] to allocate marker 1 within 5
ms time duration. [Run/Stop]

RMT
, Gate Ctrl
Al .
! | )
Wi palll] e, 1 l|!| il Gate
' \'Il fr’l\k ¥ H !.ﬁllllt~ f|( 1|| [lw .ﬂr’ ”1 234
} | f LS
' | ﬂ | ‘ Select
| | l | (L3S TgDel
| !I (L —
s Marker
1| 2 e
¥:Start-400us B00us /Div ¥ :Top20.00dBm10.00d EfDiv Jl
1 Time: -8.70us | AT: 5.01ms :
Pow: -30.39dBm | pug: -5.91dBm CTI::“:’
HTime: 5.00ms ‘Peak: 6.99dBm peera
| Pow: -0.16dBm || Pk-Avg: 12.90dB
10f2 b |

Figure 22. WiMAX waveform duration at bms forr both DL and

UL in TDD mode

UL Zone#1
Type: PUSC
Length: 15 sym{s)

Max# of Subch:35 chis)

Amplitude; -4,45 db

Amplitude: -10.27 dB

[Gap(TTG)
nagth: 340.00 us
|&mplitude: --- dB

Max# of Subch:3S chis)
Amplitude: -4,58 dB

5.000 ms

Figure 23. Frame duration (5 ms) of DL and UL waveforms captured with Signal Studio
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Measuring Preamble PvT
Instructions Keystrokes

On the P-Series power meter:

Measure the Preamble at 104 us

duration (See Figure 24). Prgss [ [ *] to allocate marker 2 and

[ xl] to allocate marker 1.

RMT
Gate Ctrl
I | T NI e 1y Gate
] s, b b fi
Iy ‘|||| AR I.‘ rlf ;|'|I|'I54 '.’Y' \H] r‘i |Ir g234
| I Select
| l L| [IE Tabel
| Ml UI Marker
K:Sta-ﬁl[lﬂus G00us SDiv ¥ :Top20.00d Brm10.00d EFDiw 18
1 Time: -8.70us AT: 104us
Pow: -30.39dBm | aug: -0.12dBm CTr::“:EI
HTime: 95.7us Peak:  4.11dBm onue
Pow: 2.95dBm Pk-Avg: 4.23dB
10f2 b

Figure 24. Preamble average power measures —0.12 dBm at 104 pus duration

Measuring DL PvT
Instructions Keystrokes

On the P-Series power meter:

Measure the DL duration with only p [ I ker 2
Burst 1 ON (See Figure 25). ress [ =] to allocate marker 2 and

[ x'] to allocate marker 1.

RMT
Gate Ctrl
Gate
|um\k||| ,.\' |1 rl(kllﬁ "” v ] n234
| —
| 1 ‘ Select
{ | MrishBIT
T —
Marker
¥ Start-400us ﬁﬂﬂus SOiw ¥ :Top20.00dBrm10.00d Ef Diw 18
1Time: 252us AT: 1.26m=
3 Trace
Pow: -3.26dBm Aug: -4.25dBm Control
ATime: 1.50ms Peak:  6.46dBm kil
Pow: -3.26dBm | Pk-Avg: 10.71dB
10f2 b

Figure 25. DL average power measures —4.25 dBm at 1.25 ms
duration where only Burst 1 is ON
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Measuring UL PvT
Instructions Keystrokes

On the P-Series power meter:

Measure UL duration with only Burst ["“\
1 ON (See Figure 26). Prgfs [ =] to allocate marker 2 and

—
[Cx.'] to allocate marker 1.

RMT
Gate Citrl
Al
1} ' |
A N e P Gate
. w 1,!,:‘1‘{ IFH || “"""'d“‘ | T | bz234
) - . meee
' ' Select
| (LI TgDel
" Marker
1 2 ﬂz
e Start-d00us 600us SDiv Y :Top 20.00dBrm10.00d B Diw
dTime: 2.55ms AT: 1.28m=s
. Trace
Pow: -4.03dBm Avg: -1.34dBm Control
2 Time: 3.83ms Peak:  6.75dBm ontro
Powe: -5.58dBm Pk-Avg: 10.99dB
1o0f2 b

Figure 26. UL average power measures —4.24 dBm at 1.28 ms
duration where only Burst 1is ON

Measuring TTG PvT
Instructions Keystrokes

On the P-Series power meter:

Measure the TTG at 339 ps duration

T
(See Figure 27). Pr(_afs [ [_ ] to allocate marker 2 and

—=
[C“-_-l] to allocate marker 1.

RMT
Gate Ctrl
Al 5
! ) !
el i, o) U e i, Gate
'w !""Wlli' | .._“._”q‘ r|{ 41"1,5, |.!hw I"ir .lIr e
: |
‘ I | ’ Select
| | l iJ [ TgDel
|| ull U| Marker
1 (2 16
HeStart-400us G00us fDiv ¥ :Top 20004 Brm10.004 EfDiw
1 Time: 216ms AT: 339us T
Pow: 6.36dBm  Aug:  -33.03dBm Cu;:’:;
HTime: 2.50ms Peak: -6.19dBm
~ Pow: -69.15dBm | Pk-Avg: 26.34dB
102 b

Figure 27. TTG at 339 us duration

23



Measuring RTG PvT
Instructions Keystrokes

On the P-Series power meter:

Measure the RTG at 965 us duration

B
(see Figure 28). Prefs [ [ ] to allocate marker 2 and

—
[C “J] to allocate marker 1.

RMT
Gate Ctrl
A1
b — | i Gate
T 1 I S W .1 ST, W
' w ‘,"'I'\ia' lp' f “-.,-.,'l“ 'lf It‘"*||'IHJ~I '.!h \H 234
| | e
‘ I ﬂ Select
| (LI TgDel
" ’I Marker
HStart-400us G00us fDiv ¥ :Top 20004 Brm10.004 EfDiw a2
g Time: 4.03ms AT: 965us
- Trace
Pow: -5.58dBm Avg: -25.04dBm
= Control
2 Time: 5.00ms Peak: 2.00dBm
Pow: -0.16dBm @ Pk-Avg: 27.04dB
102 b

Figure 28. RTG at 965 s duration
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Ordering Information

Product type Model number
P-Series Power N1911A or
Meters N1912A
P-Series Wideband N1921A or
Power Sensors N1922A

For further information, refer to:
P-Series Power Meters and Power
Sensors Configuration Guide,
5989-1252EN

Product Web Site

For the most up-to-date and complete
application and product information,
visit our product web site at:

www.agilent.com/find/wideband_
powermeters

For additional information, visit:

www.agilent.com/find/wimax
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